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Are you curious how to type the degree symbol () on any device or platform? Have you ever been puzzled by entering this particular character? This guide is specially tailored for you, providing foolproof methods to effortlessly type the degree symbol on Windows, Mac, Linux, Word, PowerPoint, Google Docs, Android, iPhone, or even social media
platforms like Facebook, Instagram, and Twitter. Not only that, but well also show you how to insert it in your emails or CMS. This informative guide promises practical solutions, saving you time and eliminating confusion. So, why wait? Keep reading to master the art of inserting the degree symbol anywhere. Trust us; youre in the right place to learn
this handy skill! Lets get started! The degree symbol, often seen in temperature readings and geometry, is a small, superscripted circle that adds a specific meaning to the numbers it follows. Primarily, this mathematical symbol is used to denote degrees of temperature or angle; the degree symbol is essential in various fields like science, math, and
everyday communication. Its a small detail, but its absence can lead to misunderstanding or confusion. Imagine youre reading a weather report without the degree symbol. Youd be left guessing the temperature measurement. Is it Fahrenheit, Celsius, or maybe even Kelvin? The degree symbol sets you free from this ambiguity, concisely offering clear
understanding. Similarly, in geometry, if youre dealing with angles, the degree symbol helps differentiate between the angles measure and other numerical values. Without it, you might mistake an angle for a whole number. Heres a table with instructions on how to include the degree symbol across various devices and platforms:
Platform/DevicelnstructionsWindowsPress Alt + 0176 or Alt + 248 on the numeric keypad.MacPress Option + Shift + 8 or Option + K.LinuxPress Ctrl + Shift + U, then type 00BO and press Enter.Smartphones (i0S)Hold the 0 key until the degree symbol appears, then select it.Smartphones (Android)Hold the 0 key or the dot (.) key until the degree
symbol appears, then select it. HTMLUse the entity ° or the numeric code °.WordPressUse the HTML entity ° in the Text editor.Google ApplicationsGo to Insert > Special characters, search for degree, and select it.Microsoft Office ApplicationsPress Alt + 0176 or use the Symbol insert feature (Insert > Symbol > More Symbols > Special
Characters).Social MediaUse the devices native method (e.g., smartphone keyboard long-press on 0 for iOS and Android) or copy and paste the symbol ().UnicodeUse the Unicode character U+00B0 by typing 00B0 and then pressing Alt + X in Microsoft Word or similar applications that support Unicode input shortcuts.ASCII Codel76 (Extended
ASCII) These instructions should enable users to easily include the degree symbol in their text across various platforms and devices. Keep reading for more detailed instructions. On Windows, its quite straightforward to type the degree symbol. All you need is a keyboard and the know-how. Its as simple as pressing a few keys in a specific sequence.
Heres a step-by-step guide: To type the degree symbol () in Windows, whether you have a numeric keypad or not, here are the methods you can use: Ensure Num Lock is turned on. Hold down the Alt key. Type 0176 on the numeric keypad. Release the Alt key, and the degree symbol will appear. If your keyboard lacks a numeric keypad, you can still
type the degree symbol using one of the following alternatives: Open the On-Screen Keyboard by searching for it in the Start menu or by going to Settings > Ease of Access > Keyboard and turning on the On-Screen Keyboard switch. Once the On-Screen Keyboard is open, click the Alt key on the screen, then type 0176 using the on-screen numeric
keypad. Release the Alt key on the On-Screen Keyboard to insert the degree symbol.Open Character Map by searching for it in the Start menu. Look for the degree symbol, which you can find by scrolling down the list or by selecting Unicode in the Character set dropdown menu and searching for U+00BO0. Select the degree symbol, click on the Select
button, then click Copy. Paste the symbol into the document or field where you need it. Some laptops and compact keyboards allow the input of Unicode characters directly through a combination of key presses, often involving the Fn key or special software provided by the manufacturer. This method varies greatly between hardware, so consult your
devices manual for instructions. As a universal method, you can find the degree symbol in another document or a webpage or use a search engine. Then, simply copy and paste the symbol where you need it. These methods provide flexibility for typing the degree symbol in Windows, accommodating various types of keyboards and user preferences.
This method is effective in most applications that accept text input, including word processors, web browsers, and email clients. Remember, you must use the numeric keypad, not the number keys above the letters. If youre using a laptop without a numeric keypad, youll need to enable the NumLock function first. This method allows you to insert the
degree symbol anywhere, whether in a word processor, web browser, or other software. There is no need to copy-paste or search for the symbol online. Now, isnt that liberating? Like in Windows, you can easily type the degree symbol on a Mac. Its as simple as hitting a couple of keys. Lets guide you through the process step by step. Open your
application: This might be your word processor, email client, web browser, or any other app where you want to type the degree symbol. Embrace the freedom to utilize the Degree Symbol anywhere! Place your cursor: Position it exactly where the degree symbol appears. Youre in control here. Press the Shift and Option keys together: This is your
gateway to accessing special characters on your Mac. Its amazing what these keys can reveal! While holding these keys, press 8: Voil! The degree symbol magically appears. Isnt that empowering? Isnt it liberating to know youre not bound by restrictions when typing special characters? You dont need additional software or tools just your Mac and
fingers. Now, type that degree symbol confidently, and take command of your digital writing. The power to communicate effectively and professionally is in your hands. Are you curious about how to type the degree symbol on Linux? Youre in luck because its straightforward. With its open-source nature, Linux allows you to customize and manipulate
your system as you wish. Heres a simple four-step guide on how to type the degree symbol to help you. Open your document: This could be a text editor like Gedit, LibreOffice, or any other application where you want to type the degree symbol. Press Ctrl + Shift + U. This combination opens Unicode input mode, a special feature in Linux that allows
you to input various symbols and characters. Type 00BO0: This is the Unicode for the degree symbol. As soon as you type this, youll notice that the string appears underlined. Press Enter: After youve typed the Unicode, just hit Enter. The degree symbol will appear in your document. Et voil, youve just typed the degree symbol on Linux! Remember,
Linux is all about freedom, including the ability to insert any symbol you want anytime, anywhere. Keep exploring and embrace this platforms versatility. You may wonder how to type the degree symbol on Linux smartphones and tablets. Dont worry; its not as complicated as it seems. Just follow a simple step-by-step process well outline for you next.
Lets begin by going through the step-by-step process of typing the degree symbol on your Linux smartphone or tablet using iOS keyboard shortcuts. Freedom is yours: Unleash the power of your device. Open a text field where you want to insert the degree symbol. Embrace the shortcut: Access your iOS keyboard. Press and hold the 0 key. A mini-
menu will appear above the key. Liberate your expression: Glide your finger to the degree symbol in the mini-menu. Release your hold, and voila, the degree symbol is typed. Celebrate your mastery: Rejoice in your new knowledge. You can now use the degree symbol anytime, anywhere. With these shortcuts, youve gained more control over your
device, empowering you to express yourself precisely and easily. Freedom in digital expression is yours for the taking. Ever wondered how to type the degree symbol on your Android device using keyboard shortcuts? Its simple and liberating! Follow these steps: To type the degree symbol () on an Android device, follow these steps: Open the keyboard
by tapping on a text input field. Press and hold the 0 (zero) key. After a short delay, a pop-up will appear showing the degree symbol. Without lifting your finger, slide it over to the degree symbol to select it. Release your finger to insert the degree symbol () into your text. The exact appearance and steps may vary slightly depending on the Android
version and the keyboard app youre using, but this method works for most standard Android keyboards. This quick process allows you to insert the degree symbol easily in your texts or emails. You wont have to search through endless symbol lists! Remember, you control your Android device, not the other way around. Master these shortcuts and
expand your typing freedom. Its your device; use it to its full potential! On your Chromebook, hitting the Ctrl + Shift + U keys, followed by typing B0 and pressing Enter, swiftly inserts the degree symbol into your document. This simple method empowers you to add the degree symbol without navigating complex menus or remembering obscure
codes. Here are some additional tips to enhance your typing experience: Use this shortcut in any text field, whether composing an email, working on a document, or filling out online forms. Practice the shortcut a few times to commit it to memory for even quicker access in the future. Remember, the B0 is case insensitive, so dont worry about toggling
caps lock on or off. Embrace the freedom of efficiently expressing temperature, angles, or coordinates on your Chromebook with this straightforward technique. Typing the degree symbol in HTML and the web is a simple process thats easy to master. You dont need to dread or avoid it. With just a few keystrokes, you can accomplish this task with
ease. Heres how to type the degree symbol in HTML and Web: Open your HTML editor: You dont need any fancy software. Any basic HTML editor will do. Locate the text: Find the place in your HTML document where you want to insert the degree symbol. Type the code: Input the specific HTML entity for the degree symbol. This is ° or °. These codes
represent the degree symbol in HTML. Save and view your work: After inserting the code, save your HTML document and open it in a web browser to see the degree symbol. This process liberates you from the limitations of your keyboard. It allows you to express your thoughts and ideas without hardware constraints. Its just one more tool in your
toolbox, empowering you to communicate effectively and efficiently on the web. Now, youre not just a web user but a web creator. If youre working on a WordPress site, inserting the degree symbol is a breeze. Your keyboards limitations dont restrict you. Freedom is in your hands, as you can manually add the Degree Symbol using HTML character
entities, a universal language that your website understands. To type the degree symbol () in WordPress, you have multiple options depending on your preference and the tools available within your WordPress editor. Heres how to type the degree symbol using the most common methods: Windows: Hold Alt and type 0176 on the numeric keypad. Mac:
Press Option + Shift + 8. In the WordPress text editor, switch to the Text or HTML view and use the HTML character code for the degree symbol: Type ° or ° at the desired location in your content. If youre using the Gutenberg editor: Click on the place in your post or page where you want to insert the degree symbol. Use the direct keyboard input
method mentioned above to type the degree symbol.Find the degree symbol in another document or web page, copy it, and paste it directly into your WordPress editor. For a more user-friendly approach, especially if you frequently need to insert special characters: Install a plugin that adds a special characters insertion feature to your WordPress
editor, such as Insert Special Characters for Gutenberg. After installing and activating the plugin, open the post or page editor. Look for the Special Characters button the plugin adds, usually in the toolbar. Click on it and select the degree symbol from the available characters. These methods offer flexibility and convenience for adding the degree
symbol to your WordPress content, ensuring you can accurately convey temperature measurements, mathematical degrees, and more. Its that simple! Embrace this newfound freedom. The restrictions of your keyboard no longer tie you down. With a few clicks and keystrokes, you can include the degree symbol, opening up a world of possibilities in
content creation. Moving on to Google Docs, Sheets, and Slides, youll find inserting the degree symbol straightforward. Googles suite of productivity tools makes it easy for you to add the degree symbol to your documents, giving you the freedom to express your ideas without restrictions. Heres a simple step-by-step guide that will help you insert the
degree symbol in no time: Open your document in Google Docs, Sheets, or Slides. Click where you want to insert the degree symbol. Go to the top menu, click Insert, then select Special Characters. In the search box that appears, type degree. The degree symbol will appear in the drop-down list. Click on it, and it will immediately be inserted into your
document. With these steps, you can insert the degree symbol anytime, anywhere. You wont be tied down by complicated processes or software restrictions. So go ahead and make your documents more accurate and expressive with the degree symbol. After all, your freedom to communicate your thoughts precisely makes Googles tools so user-
friendly and versatile. Lets move on to how to type the degree symbol in Microsoft Office. The process varies slightly between Word, Excel, and PowerPoint, but dont worry, its quite straightforward. Ill guide you through each application step by step, ensuring youll understand it quickly. Heres how to type the degree symbol in Word: In Microsoft
Office, you can easily type the degree symbol by following simple steps. Heres a step-by-step guide to liberating your documents from plain texts constraints. Open your Word document and find where you want to insert the degree symbol. Click on the Insert tab at the top of your screen. From the dropdown menu, select Symbol, and then More
Symbols. A new box will appear. Scroll down until you see the degree symbol and click on it, then press Insert. Voila! Now, you can sprinkle your documents with degrees, enhancing them beyond the ordinary. No need to feel tethered anymore. Express yourself freely, the world of Word is your oyster. Ever wondered how to insert the degree symbol
in Excel? Good news! Its simple and straightforward. Heres how to type the degree symbol in Excel: To start, open the Excel sheet where you want to add the degree symbol. Next, click on the cell where you want the symbol to appear. Press the Alt key on your keyboard and while holding it down, type 0176 on the numeric keypad. Make sure youre
using the numeric keypad, not the numbers at the top of the keyboard. Release the Alt key and voila! The degree symbol appears in your cell. You might be surprised at how easy its to insert the degree symbol in PowerPoint. No more feeling shackled by the limitations of your keyboard. Heres your 4-step guide to freedom: Open your PowerPoint
presentation and click on the slide where you want to insert the degree symbol. Click on the Insert tab in the menu bar, then select Symbol. In the symbol dialog box that pops up, select More Symbols. A new box will appear. Find the degree symbol (), click Insert and then Close. And voila! Youre free to express temperatures, angles, or whatever
requires a degree symbol with ease. Embrace the freedom that comes with mastering PowerPoints full capabilities. Youve gained a new skill, and it wasnt that hard, was it? Youre likely wondering how to type the degree symbol on social media platforms like Facebook, Twitter, and Instagram. Its not as complicated as you might think, and were about
to break it down for you. Heres how to type the degree symbol in social media: Lets get you started on these simple steps. On Facebook, typing the degree symbol in your posts or comments isnt as tough as it might initially seem. The process is as simple as a breeze. Youll feel a sense of liberation, knowing you can easily express temperatures, angles,
or geographic coordinates right from your fingertips. Open Facebook: Simply log into your account. Prepare to Post: Click on the field where you want to type, be it a post, comment, or direct message. Access Symbols: Press and hold the 0 (zero) key on your mobile device keyboard. The degree symbol will appear as an option. Select the Degree
Symbol: Just tap on it, and voila! Feel the freedom of expression, unhindered by technical limitations. Its your world; express it your way. Exploring Twitters terrain, inputting the degree symbol becomes a piece of cake with a few easy steps. Youll appreciate the freedom to express temperature, angles, or any concept requiring the Degree Symbol.
Heres your brief step-by-step guide: To type the degree symbol () on Twitter, you can use several methods depending on the device youre using: Make sure Num Lock is on. Hold down the Alt key and type 0176 on the numeric keypad. Release the Alt key to insert the degree symbol ().Find the degree symbol in another document or web page, copy it,
and then paste it into your tweet.Press Option + Shift + 8 to type the degree symbol directly.Locate the degree symbol elsewhere, copy it, and paste it into your tweet.Tap to bring up the keyboard in the Twitter app or on the Twitter website. Press and hold the 0 key. After a moment, a mini-menu will appear with the degree symbol. Slide your finger
over to select the symbol and release to insert it.Tap to open the keyboard within the Twitter app or web interface. Press and hold the letter O or the 0 key, depending on your keyboard layout. A small pop-up should appear with the degree symbol. Without lifting your finger, slide it over the degree symbol to select and insert it into your tweet. These
methods allow you to include the degree symbol in your tweets, useful for sharing temperature details, scientific data, or mathematical content directly on Twitter. Just like that, youve mastered the degree symbol on Twitter. Enjoy this newfound freedom! Shifting our focus to Instagram, lets master the art of typing the degree symbol on this popular
social media platform. Youre not confined to the limited keyboard of your device. Theres a simple process to follow. Access the numeric keyboard. Start by writing your caption or comment, then tap the 123 button to access more symbols. Find the additional symbols. Tap the +=\< key to reveal even more symbols. Locate the degree symbol. The
elusive degree symbol () sits comfortably next to the percent (%) symbol. Insert the degree symbol. Tap it, and itll magically appear in your text. You see, your freedom to express yourself on Instagram isnt limited. Go ahead and post that temperature or angle with the degree symbol! How to Type the Degree Symbol in Content Management Systems
(CMS) other than WordPress, Including Joomla and Drupal. If youre working with Content Management Systems like Joomla or Drupal, heres how you can effortlessly type the degree symbol. You must understand that youll be dealing with HTML in these systems. Youre not limited by a specific keyboard layout or language setting, and you can
express your content without restrictions. To type the degree symbol, youll use an HTML entity. In your content editor, place your cursor where you want the degree symbol to appear. Then, simply type . Thats the HTML entity for the degree symbol. Once your content is live, will show as . Its that simple. You might think, What if I forget the HTML
entity? Dont worry. Theres no need to memorize. Most CMSs, such as Joomla and Drupal, have an Insert Special Character button in their editor toolbar. Click on it, and youll see a range of special characters, including the degree symbol. Just click on it, and itll be inserted into your content. Typing the degree symbol in an email is just as simple as
you might hope. You can insert this handy symbol into any email youre drafting without any hitches or glitches. Remember, youre in control here, and theres no need to feel overwhelmed. Open your email client: Whatever email platform youre using, whether its Gmail, Yahoo, or Outlook, the process remains fundamentally the same. Start drafting
your email: Click on the Compose or New Email button, and start typing your message. Insert the degree symbol: If youre on a PC, hold down the Alt key and type 0176 on your number pad. For Mac users, press Option and 0 at the same time. Hit Send: Once youve inserted the degree symbol (), finish your email and confidently hit the Send button.
The power to use the degree symbol in any email is just a few keystrokes away. Remember, its your email, your rules. Youre not bound by any limitations, so break free and type away. Freedom in communication is your right, so explore it to the fullest. In LaTeX, typing the degree symbol is simple: just use the command \degree in math mode. This
method allows you to include the degree symbol wherever you need it in your document without any difficulty. To guarantee clarity and accuracy in your LaTeX documents, here are a few suggestions: Make sure youre in math mode by enclosing your command with $ symbols: $\degree$. For a more advanced appearance, consider using the gensymb
package by including \usepackage{gensymb} in the preamble, which permits \degree outside of math mode. Keep in mind, spacing is important in LaTeX. To prevent common errors, insert a small space before the degree symbol when it comes after a number, like 10\,$\degree. How to Type the Degree Symbol in Text Editors and IDEs (Integrated
Development Environments) Moving from emails to text editors and Integrated Development Environments, youll find that typing the degree symbol is just as simple and hassle-free. Whether coding in Python, drafting a document in Google Docs, or jotting notes in Notepad, the process remains the same. If youre on Windows, press and hold the Alt
key, then type 0176 using the numeric keypad. Ensure youre using the numeric keypad, not the numbers at the top of the keyboard. For Mac users, press Option + Shift + 8. Linux users, youre not left out. Hold down Ctrl + Shift and type u00b0, then release everything. Voila, youve got the degree symbol. IDEs like Visual Studio or Intelli] allow you to
directly copy the degree symbol () from a web page and paste it in your code. Most IDEs support Unicode characters, so you should have no problems. Despite its simplicity, a few handy tips can make using the degree symbol even easier. Be comfortable with shortcuts: The degree symbol isnt typically found on your keyboard, but that doesnt mean
you cant quickly access it. Learn the keyboard shortcuts for your device, and youll be typing without any hassle. Use the right symbol: Its easy to confuse the degree symbol with similar-looking ones, such as the diaeresis () or the ring (). Make sure youre using the correct symbol to avoid any ambiguity. Check your spacing: While the degree symbol is
usually typed immediately after the number without a space (e.g., 30), some style guides suggest using a narrow, non-breaking space for better legibility. Know your style guide and stick to it. When in doubt, copy-paste: If you struggle to get the symbol right, find it online and copy-paste it. This foolproof method always yields the right symbol. We
hope you learned how to type the degree symbol across various platforms. Mastering the degree symbol keyboard shortcut can greatly enhance your workflow, whether youre a student, writer, or developer. This guide has offered simple steps applicable across various platforms and applications. With regular practice, using the degree symbol will
soon become second nature, increasing your productivity and precision. Always remember that a quick way to input the degree symbol exists regardless of your device or platform. We encourage you to share the content of this article with others, particularly those who could benefit from learning how to insert the degree symbol easily. Sharing this
knowledge can help others improve their efficiency and accuracy in their work or studies. Lets spread the word and make typing more enjoyable and less challenging. What is the Degree Symbol? Youve seen it countless times beforethat tiny circle hovering above numbers in a recipe, a math problem, or perhaps on your phones weather app. Its the
degree symbol, a key Check it Out! Are you curious about how to type the sigma symbol ()? Discover the efficiency of using symbols like the Sigma () across all your devices and platforms for calculations and presentations. Continue reading to learn Check it Out! Are you curious how to quickly type the Multiplication Symbol (x)? This article provides a
simple solution to your symbol typing queries. Discover efficient methods for typing the multiplication symbol (x) on various devices, ensuring Check it Out! Are you curious about how to type the Integral Symbol? Wondering how to type it on different devices? This article will provide a simple guide to help you easily type the Integral Symbol on
various Check it Out! Unlocking the Secrets for Linguists and Language Learners Are you curious about those unique symbols in English phonetics, like , , and ? Have you ever wondered how to type phonetic symbols or what they Check it Out! Chemical Symbols Heraldic Symbols Clothing Symbols Ancient Scripts Phonetic Symbols Legal Symbols
Electronic Symbols Masonic Symbols Political Symbols Religious Symbols Food Symbols Biological Symbols Safety Symbols Weather Symbols How can I send an email to WordPress with a suggestion about the options that are available when editing ones blog The blog I need help with is: (visible only to logged in users) There are custom characters
you can use found in the Visual editor Row 2 icon 7. See here The degree symbol is in the middle of the 4th row there. P.S. Suggestions to Staff are made in the Ideas Forum symbol:from Microsoft Windows, there are several ways to make the degree symbol: One can type Alt+248 or Alt+0176 Note: The NumLock must be set first; on full size
keyboards, the numeric keypad must be used; on laptops the virtual numeric keypad must be used. Note: Alt+0186 is often cited as the same degree symbol, but is actually a masculine ordinal indicator. The Character Map tool also may be used to obtain a graphical menu of symbols. The US-International English keyboard layout creates the degree
symbol with AltGr+ Shift+:How can financial brands set themselves apart through visual storytelling? Our experts explainhow.Learn MoreThe Motorsport Images Collections captures events from 1895 to todays most recentcoverage.Discover The CollectionCurated, compelling, and worth your time. Explore our latest gallery of EditorsPicks.Browse
Editors' FavoritesHow can financial brands set themselves apart through visual storytelling? Our experts explainhow.Learn MoreThe Motorsport Images Collections captures events from 1895 to todays most recentcoverage.Discover The CollectionCurated, compelling, and worth your time. Explore our latest gallery of EditorsPicks.Browse Editors'
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Share copy and redistribute the material in any medium or format for any purpose, even commercially. Adapt remix, transform, and build upon the material for any purpose, even commercially. The licensor cannot revoke these freedoms as long as you follow the license terms. Attribution You must give appropriate credit , provide a link to the license,
and indicate if changes were made . You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use. ShareAlike If you remix, transform, or build upon the material, you must distribute your contributions under the same license as the original. No additional restrictions You may not apply legal terms or
technological measures that legally restrict others from doing anything the license permits. You do not have to comply with the license for elements of the material in the public domain or where your use is permitted by an applicable exception or limitation . No warranties are given. The license may not give you all of the permissions necessary for
your intended use. For example, other rights such as publicity, privacy, or moral rights may limit how you use the material. Ever wanted to add a special character while working within the WordPress block editor (Gutenberg) and suddenly find yourself longing for the days of the Classic Editor and the Special Character inserter? Well long no more,
the Insert Special Characters plugin is here to ease your publishing woes!Note: you can display the popover via the ctrl/cmd + o keyboard shortcut.Development takes place in the GitHub repository.Technical Notes ExtendingTo control the available tabs and characters, developers can filter the data set using the insertspecialcharacters-characters
JavaScript (wp.hooks) filter.For example, to create a character inserter that only provides currency symbols:wp.hooks.addFilter( 'insertspecialcharacters-characters', // The filter name. 'mycallback’, // Our callback namespace. function( component ) { // The callback function. // Return the categories/characters to display. // The data structure is: {
category: [ character data ], category?2: ... } return { "Currency": [ { "entity": "$", "hex": "", "name": "Dollar Sign", "char": "$" }, { "entity": "€", "hex": "AC;", "name": "Euro Sign", "char": "" }, { "entity": "¢", "hex": "@A2;", "name": "Cent Sign", "char": "" }, { "entity": "£", "hex": "@A3;", "name": "Pound Sign", "char": "" }, { "entity": "¥", "hex": "@AS5;",
"name": "Yen Sign", "char": "" }, ] }; }); Example of special characters selection in the Block Editor.Special Characters option in Paragraph Block menu.Initial special characters, showing the Math character set.Filtering the special characters via search.Resulting inserted special character (note focus on special character, rest of window has been
blurred). Install the plugin via the plugin installer, either by searching for it or uploading a .zip file.Activate the plugin.Use Insert Special Characters! When a character is displayed using a font that doesnt support that character, a default not defined glyph from that font is used. The not defined glyph in most fonts has the appearance of a rectangular
box, or some variation of that.One example of a font with support for wide range of glyphs is the Noto family by Google Fonts, which can be loaded by the theme to render the missing characters. Easy and useful. I like it! As a lover of em dashes, en dashes, diacritics, and typography and Unicode in general, and a pedant for using the precise, proper
characters where they are appropriate, this plugin does exactly what I need it to do. It works very similarly to the insert-special-characters feature of MediaWikis VisualEditor plugin, which I also love. Bravo for this, and please keep up the good work. THANK YOU! I am a typographer from way back when I was hand-setting (and pieing the term for
spilling) little pieces of metal in the forms of letters, numbers & dingbats. Special Characters is the WordPress feature I have missed most in Gutenberg, and your plugin is the first & only that makes inserting Special Characters easy and enjoyable. Look for a donation from this old type lover! Thank You!lt solves a big problem in Gutenberg, which
misses this function! Thank you for this great plugin! WHY special characters are STILL absent from the Gutenberg Wordpress editor though it has been requested numerous times is quite the annoyance. This plugin is perfect! Thanks again! This is perfect for me. Thanks for developing it!If there was an option to move it to the main toolbar without
the need to use the dropdown, it would be a six-star product Read all 8 reviews Changed: Update the UI to be more consistent with WordPress core props (@psorensen, @fabiankaegy via #263).Changed: Clean up NPM dependencies and update node to v20 (props @Sidsector9, @dkotter via #238).Changed: Bump WordPress tested up to version 6.7
(props @sudip-md, @sonali886, @godleman, @jeffpaul, @dkotter via #260, #261, #273, #274).Security: Bump express from 4.18.2 to 4.19.2, follow-redirects from 1.15.5 to 1.15.6, ip from 1.1.8 to 1.1.9 and webpack-dev-middleware from 5.3.3 to 5.3.4 (props @dependabot, @iamdharmesh via #254).Security: Bump braces from 3.0.2 to 3.0.3, pac-
resolver from 7.0.0 to 7.0.1, socks from 2.7.1 to 2.8.3, ws from 7.59 to 7.5.10 and removes ip (props @dependabot, @faisal-alvi via #259).Security: Bump axios from 1.6.7 to 1.7.7, body-parser from 1.20.2 to 1.20.3, express from 4.19.2 to 4.21.0, ws from 7.5.10 to 8.18.0, @wordpress/scripts from 27.1.0 to 29.0.0 and webpack from 5.90.0 to 5.94.0
(props @dependabot, @Sidsector9 via #267, #268).Added: Support for the WordPress.org plugin preview (props @dkotter, @jeffpaul via #232).Fixed: Issue with blocks crashing due to faux caret (props @Sidsector9, @dkotter, @ankitguptaindia via #225).Fixed: Issue with characters added to the beginning trimming text from the end (props
@Sidsector9, @dkotter, @ankitguptaindia via #225).Changed: Bump WordPress tested up to version to 6.4 (props @gasumitbagthariya, @jeffpaul, @QAharshalkadu, @ankitguptaindia, @dhanendran, @iamdharmesh via #228).Fixed: Address an issue where some blocks would crash due to a missing attribute (props @dkotter via #221).Security: Bump
@babel/traverse from 7.20.5 to 7.23.2 (props @dependabot, @dkotter via #219).Added: Show a faux cursor to preserve context (props @Sidsector9, @helen, @ravinderk via #207).Added: Check for minimum required PHP version before loading the plugin (props @kmgalanakis, @peterwilsoncc via #210).Changed: Bump WordPress tested up to
version to 6.3 (props @kmgalanakis, @jeffpaul, @peterwilsoncc via #212, #215).Fixed: Ensure that when highlighting a special character, the block doesnt crash (props @jrmd, @dkotter via #204).Security: Bump semver from 5.7.1 to 5.7.2 (props @dependabot, @dkotter via #202).Security: Bump word-wrap from 1.2.3 to 1.2.4 (props @dependabot,
@Sidsector9 via #206).Security: Bump @cypress/request from 2.88.10 to 3.0.0, cypress from 12.8.1 to 13.3.1 and @10up/cypress-wp-utils from 0.1.0 to 0.2.0 (props @dependabot, @dkotter via #213).Security: Bump tough-cookie from 4.1.2 to 4.1.3 and @cypress/request from 2.88.10 to 2.88.12 (props @dependabot, @ravinderk via #214).Security:
Bump postcss from 8.4.20 to 8.4.31 (props @dependabot, @faisal-alvi via #216).Further changelog entries can be found in the CHANGELOG.md file. Download Article Download Article Having to look up the degree ( ) symbol and then copy and paste it into your document every single time can get tedious. Luckily, there are easy keyboard shortcuts
you can use to type the symbol whether you're using a Windows or Mac computer or your iPhone or Android. No copying and pasting required! 1Click where you want to add a degree symbol. The quickest way to add a symbol to text is to use keyboard shortcuts. You can use Alt codes in Windows. Mac computers have their own keyboard shortcut.
You can also use special shortcuts in Word and Excel. Click where you want to add a degree symbol in an email, social media post, private message, or any text document. 2Press Shift+ Option+8 on Mac. If you are using a Mac computer, press Shift + Option + 8 at the same time to add a degree symbol to your text. Advertisement 3Press
Shift+Ctrl+@ followed by Space in Microsoft Word. If you are using Word, you can add a degree symbol by typing Ctrl+@ followed by the Spacebar.4Type =CHAR(176) in Microsoft Excel. If you are using Excel, you can add a degree symbol by typing "=CHAR(176)" in a cell.5Press and hold Alt and type 0176 on Windows with a numeric keypad. If you
are using a Windows computer that has a 10-key numeric keypad on the right side, press and hold the Alt key while typing 0, 1, 7, and then 6 on the keypad. Don't use the number row at the top. When you release the Alt key, you should see a degree symbol added to your text.[1]If this does not work, press the "Num Lock" key and try again.
Advertisement 1Click where you want to add a degree symbol. This can be any app that allows you to write text. It can be an email, social media post, private message, or text document.2Press the Windows key + the period key. Pressing the Windows key and the Period (.) key at the same time displays the Emoji keyboard in Windows.3Click . It's the
symbol that resembles a horseshoe symbol at the top of the Emoji keyboard. This displays symbols.4Scroll down and click . Locate the degree button in the list of symbols and click it to add a degree symbol to your text. Advertisement 1Click the Start menu. It's the icon with the Windows logo in the lower-left corner.[2]2Type in character map. This
will search your computer for the Character Map program.[3]3Click Character Map. It's a triangular app icon at the top of the Start window. Doing so opens Character Map.[4]4Check the "Advanced view" checkbox. You'll find this box near the bottom of the Character Map window.If the "Advanced view" checkbox is already checked, skip this
step.5Search for the degree sign. Type "degree sign" into the "Search for" text box near the bottom of the window, then click Search. The Character Map's page will clear, and only the degree symbol will remain.You can also find the degree symbol in the sixth row of the Character Map window when you first open Character Map.6Double-click the
degree symbol. It's in the upper-left corner of the Character Map window.7Click Copy. This option is to the right of the "Characters to copy" text field.8Go to a place where you want to type the degree symbol. This might be a text document, a post on social media, or an email.9Press Ctrl+V. This pastes the degree symbol that you copied.
Advertisement 1Go to the place where you want to type a degree symbol. Open the app, document, or website into which you want to type a degree symbol, then click the text field where you want to type it.2Click Edit. This menu item is at the top of the screen. A drop-down menu will appear.[5]3Click Emoji & Symbols. You'll find this option at the
bottom of the Edit drop-down menu. Doing so opens the Character Viewer window.[6]4Click the Punctuation tab. It's on the left side of the Character Viewer window.You may first have to click the "Expand" icon, which is a box-shaped icon in the top-right corner of the window.5Find the degree symbol. The degree symbol is in the third row of symbols,
just right of the ™ symbol.There is a larger degree symbol on the right side of this same row if the one on the far-left is too small for you.6Double-click the degree symbol. This will insert one degree symbol into the text field in which your cursor is placed. Advertisement 1Click where you want to add a degree symbol. On Chromebook and Linux, you
can add a degree symbol using Unicode symbols. Click the input field that you want to add a degree symbol to.[7]2Press Shift+Ctrl+U. This displays an underlined "u" in the text.3Type 00BO on Chromebook or BO on Linux. This is the Unicode for the degree symbol.4Press Space or Enter. This converts the underlined "u" to a degree symbol.
Advertisement 10pen an app that uses the keyboard. You can add a degree symbol using your iPhone's or iPad's keyboard, but you'll need to switch to the correct view first.2Place your cursor where you want to type the degree symbol. Tap a text field (e.g., the iMessage text field) into which you want to type the degree symbol. The keyboard should
appear.3Tap 123. This button is in the lower-left corner, and will switch the keyboard to show numbers and some symbols.[8]4Press and hold the "0" button. The 0 button is at the top of the keyboard. After a brief moment, a pop-up menu will appear above the 0 button.[9]If you're on an iPhone 6S or newer, make sure that you lightly press the 0
button, as pressing down on the screen will activate 3D Touch instead of the menu.5Select the degree symbol. Slide your finger over to the degree symbol, make sure that it is highlighted, and then release your finger. This will insert the degree symbol into the text that you're writing. Advertisement 10pen an app that uses your device's keyboard. The
degree sign is available in the Symbols section of your Android's keyboard.2Place your cursor where you want to type the degree symbol. Tap a text field (e.g., the Messages text field) into which you want to type the degree symbol. The keyboard should appear.3Tap ?123 or !#1. It's in the lower-left side of the keyboard. Doing so brings up the
numbers and symbols view.4Tap the secondary Symbols button. It's the second button from the bottom on the left. On Google GBoard, it's the button that says "=\ About". Central.wordcamp.org. May 11, 2010. Archived from the original on July 24, 2019. Retrieved August 18, 2019.” "WordCamp 2006". 2006.wordcamp.org. Archived from the original
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